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1. Introduction 
 

This document describes the best practice guidelines for implementing the baseline standard 

solution for the following: 

 

 EDM Sage X3  

 PIA Sage X3  

 SOA Sage X3 

 

Assumptions: 

  

 The installation has been completed and the post installation check list has been 

satisfied 

 

You are encouraged to bookmark the Portal which is regularly updated with information about 

the release: 

 

http://support.wearev1.com/software/x3/R13 

 

2. About this document 
 

Thanks to the generous feedback from our Partners, Customers and training delegates, this 

document is continually improved to make it as easy as possible to follow. 

 

The chapters are in the order you are recommend to complete them, starting with the EDM / 

PIA tasks, followed by those done in Sage itself and ending with a section for none standard 

implementation tasks. 

 

3. Assumptions 
 

 The Server Installation Guide has been completed in full 

 You have physical access to the V1 Server where the installation was performed 

(via remote desktop / equivalent dial in capability) 

 The DbLogin Admin Console has been installed on the V1 Server 

 

 

 

  

http://support.wearev1.com/software/x3/R13
http://support.wearev1.com/software/x3/R13/files/EDM%20for%20Sage%20X3%20-%20Server%20Installation.pdf
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4. File Transfer 
 

EDM for Sage X3 is designed to work on either an ‘On Premise’, ‘Hosted’ or ‘Cloud’ based 

infrastructure, with no functional differences. 

 

 EDD triggers the creation of outbound reports as PDF’s and distributes them 

 EDM triggers the archiving of transactions, attachments or printing of barcodes 

 PIA triggers creation of transactions in Sage 

 

All of these activities move files from server to server, PC to PC, device to device. 

 

You have two options for transferring files from the Sage X3 server to the V1 Server and 

vice versa: 

 

Option 1 

Disk 

Files are copied from one server to another via a network share. 

 

This is the standard implementation, best suited to on premise or hosted deployments where 

the two servers (Sage Application server and V1 Server) can see one another over a network. 

 

Option 2 

Email 

Syracuse is used to email files (SYRAMAIL) from the Sage X3 server to the V1 Server, the 

file is downloaded by V1SmartMail and processed as normal. 

 

This is the non-standard implementation, best suited to a Cloud based implementation where 

the two servers (Sage Application server and V1 Server) cannot see one another over a 

network. 

 

These options are controlled by a single parameter in Sage X3 called EDMARCTYPE. 

 

This guide will explain this parameter, take you through option 1 as standard and option 2 as 

none standard allowing you to choose which method is best for your implementation. 
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5. Import links 
 

EDM introduced document linking so when viewing a document in SmartRetrieve, if available, 

you will be given the option to see any attachments that relate to one another. 

 

Assumptions: 

  

 You must be logged on to the V1 Server where the Server installation has been 

performed 

 The EDM installation is under C:\V1 

 

Example 

 

 A Purchase Invoice has been created using PIA, the transaction is in Sage and the image archived 

against it. 

 AP user PETE receives 3 photographs that relate to the Invoice and archives them using the [EDM] 

Archive Attachment facility. 

 AP user PETE receives an email attachment for the Supplier so archives it using the Supplier Archive 

EDM table using SmartDeposit 

 

Usage 

 

 PETE wants to see the Invoice, the photographs he archived and the Supplier email 

 When on the Purchase Invoice transaction, clicks the [EDM] View Transaction 

 Viewing the image, selects the link to see the attachment 

 From the attachment, selects the link to see the email attachment 

 

Procedure 

 
1. Open the DbLogin Admin Console and login as administrator / administrator 

2. Click the  icon at the top of the screen 

3. Click File > Show system tables 

4. The _LINKS table will now be displayed, single click on it 

5. Click the  icon at the top of the screen 

6. Navigate to the \V1\DbArchive directory, click on the _LINKS.csv file and click Open 

7. The links are now loaded, close the Import / Export Tool 

8. To ensure they’re ready to use, click the  icon to load the Link Editor and you will see a list of all 

standard links pre-created. 

 

More links can be added at any-time, consult the Administration guide for more information.  
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6. Create Your DbLogin Users 
 

You are advised to watch this short video for a full and detailed explanation of how 

users interact between EDM / PIA and Sage X3, the steps in which you will be 

performing in the document. 

 

A DbLogin user is one that requires access to the V1 clients and Smart Suite on a day to day 

basis. 

 

This might be to login to the Smart Suite to use Smart Deposit and deposit a document, or to 

login to DbCapture Admin to view the queue of documents in PIA. 

 

A DbLogin user is the equivalent of a Sage user (NOT a Syracuse user), so a Sage user called 

PETE would need a corresponding DbLogin user called PETE to use the software. 

 

Ensure you know the details of the Sage users (remember, those in the (GESAUS) function, 

NOT Syracuse users) who wish to use EDD / EDM / PIA / SOA for each Sage Endpoint.  

 

These users can be added at any-time, but for the purposes of this document, you’re advised 

to create as many as possible as early in the implementation as possible. 

 

 
1. Open DbLogin Admin Console and log in as administrator / administrator 

2. Click the  icon at the top of the screen 

3. Click Add … 

 

NOTE: When creating users in DbLogin Admin, make sure they are 

in UPPERCASE 
 
4. Enter the Username (in upper case) matching the corresponding Sage X3 Username 

5. Enter the email address matching the Sage Workflow address for the same Sage X3 username. 

6. Enter a password (this does not need to match but is advisable) 

7. Un tick Must Change 

8. Click Update 

 

Repeat these steps for each user required 

 
9. Click Close  

https://www.youtube.com/watch?v=gwVMcDhn-to
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7. Configure External Users 
 

EDM for Sage X3 has the concept of named licensing. 

 

Now you’ve created your DbLogin users, similar in principal to badges in Sage, it means they 

can guarantee having access to certain V1 applications. 

 
1. Open the DbLogin Admin Console and login as administrator / administrator 

2. Click the padlock icon at the top of the screen, Manage Access Tokens 

 
NOTE: Here you will see a grid (based on your licenses applied during the installation) what applications have 

been licensed for. 

 
3. Click on the first application in the list and click Allocate 

4. Click on the DbLogin user on the left you wish to assign access 

5. Click the >> arrow to assign them access to the software 

6. Click Save 

7. Repeat the above steps for each application in the list based on the values you see 

8. When finished, click Close 
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8. Configure Drilldown User 
 

EDM for Sage X3 has the concept of a specific drilldown view for those users that only want 

to view images from with Sage, i.e it will only display the image rather than other options you 

may require as an external user. 

 

You are advised to create a dedicated ‘drilldown’ DbLogin user who sole job will be to 

authenticate this action. 

 
1. Open DbLogin Admin Console and log in as administrator / administrator 

2. Click the  icon at the top of the screen 

3. Click Add … 

 

NOTE: When creating users in DbLogin Admin, make sure they are 

in UPPERCASE 
 
4. Enter the Username (in upper case) DRILLDOWN  

5. Enter any email address, it does not have to adhere to any existing one and is not used. 

6. Enter a password, one that is secure but not too complex as your users will need it the first time they use a 

drilldown 

7. Un tick Must Change 

8. Click Update 

9. Repeat the steps to allocate a license to your DRILLDOWN user, but ensure to select the 

SmartRetrieveERP application and assign the maximum number in your pool 

 

Usage 
 

 Sage user PETE using the drilldown (example below) wants to see an Invoice for the first time he uses 

EDM, he clicks the [EDM] View Transaction link 

 This opens a new tab in his browser and he’s asked to login. He enters the DRILLDOWN user and 

password as supplied by his I.T department. 

 He ticks the ‘Keep me logged in’ tick box so won’t be asked again, his browser will remember these 

credentials from now on. 
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9. Configure DbLogin Users to use PIA / SOA 
 

Each DbLogin user who requires access to PIA / SOA needs to be configured as below:  

 

1. Open the DbLogin Admin Console, login as administrator / administrator 

2. Click the tick box to the left of the user you wish to configure for PIA / SOA recognition 

3. The  icon at the top of the screen should be illuminated, left click on it 

4. Single click on DbCapture in the tree 

5. For PIA, ensure the ProfilesAllowed value contains: 

 
PIAExpress 

 
6. For SOA, ensure the ProfilesAllowed value contains: 

 
SOAExpress 

 

NOTE: For multiple profiles, they should be separated by a comma  

 

7. Ensure CandidatesEnabled is ticked 

8. Ensure AccessLevel is Level5 

9. Ensure DbCStatesAllowed contains: 

 

100,101,102,103,104,105 

 

10. Click Save 

11. Your user is now configured for access to the system 
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10. Adding DbLogin users to authentication Database 
 

EDM introduced a new, cleaner way to administrate DbLogin user access to Sage Endpoints. 

 

Q: What does this actually mean? 

A: Access to a Sage Endpoint means when using SmartDeposit you can add a document, 

when using SmartRetrieve you can see a document, or when using PIA, you can see the 

queue of Documents for that Endpoint. 

 

It’s basically an extra level of security meaning the right users only have access to the right 

data. i.e. you only want your users in the Birmingham office using the BIR123 Endpoint 

 
1. Navigate to C:\EDMR13, right click and run setup.exe AS ADMINISTRATOR 

2. Select the Server Installation radio button and click Next > 

3. An existing Server Installation is detected and you’re given several options, select Manage Sage Endpoint 

Accessibility and click Next > 

4. Sage is interrogated to retrieve all Sage Endpoints. At this point, either choose to configure access to All 

Endpoints (which is advisable if you’re doing this for the first time) or select the one you wish to configure 

access to. Click Select. 

 
You now have 2 panels.  

The panel on the left are those DbLogin users which at this point, have no access to the Endpoint selected  

The panel on the right are those DbLogin users which at this point, have full access to the Endpoint selected 

 
5. Using the arrows, move your DbLogin users from left to right (or all together using the double arrow) to give 

those users access to the corresponding Endpoint. 

6. When satisfied, click Save to commit to the authentication database. 

7. When satisfied, click Close and close the installer. 

 

Q: What if I click Save and get a connection error / can’t connect? 

A: If the connection details have been changed since the original install, you will experience 

a problem connecting. 

 

On the server where EDM is installed, open the registry and navigate here:  

 

HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\EDMR13 

 

Ensure the details in the DBARCHIVE_* keys reflect the server where the DbArchive 

database is installed / change where appropriate and try again. 

 

More technical detail on the following page. 
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Technical Detail 
 

The EDM database (DbArchive) contains a table called DBA__FILTER__MAP. 

 

This table hold 2 fields: 

 

UNAME 

KEYVALUE 

 

The UNAME is the DbLogin user 

The KEYVALUE is the Sage X3 Endpoint 

 

These values dictate which Sage Endpoints a DbLogin can use when using the day to day 

components such as Smart Deposit and the DbCapture Client. 

 

 
 

 

So when using the setup program and pressing the ‘Save’ button, all you’re doing is updating 

this table. 

 

Although not recommended, you don’t even have to use the setup program. If you have a 

stored procedure / preferred method to populate this table, then feel free to use it.  
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11. Configure V1 Smart Suite 
 

The SmartSuite is the term given to the suite of programs in the EDM solution allowing the 

depositing and retrieval of documents from the database. 

 

Now installed, it must be configured. Although this can be done from anywhere with http 

access to the V1 Server where the software was installed originally, you are advised to do it 

from the same one. 
 

NOTE: You will need the SQL Server / Instance name, sql user and password you used 

to install EDM for this section. 

 

NOTE: Ensure the SQL Server service is running applicable to the database location 

prior to starting configuration. 

 

1. Open your web-browser of choice  

2. Navigate to http://localhost:5002 

3. The ‘first run’ config screen appears, change the ‘nis server address’ and port number from 

http://127.0.0.1:6181 to the name of the server you are installing on.  

 

So for example, if your server name is MYSERVER123, the ‘nis server address’ would be: 

 

http://MYSERVER123:6181 

 

NOTE: Ensure to not put a trailing slash at the end of this URL 

 
4. Click OK 

5. In the Archive JSON Configuration, again change the server name to the name or IP address of the server 

you are installing on 

6. Scroll down to the jdbc connection, remove the example. This value should be the SQL instance name 

where EDM has been installed, a ; then Database=DbArchive 

 
NOTE: An Example would be jdbc:sqlserver://MYSQLSERVER\SQLINSTANCE;Database=DbArchive 

 
7. Enter the same user and password you entered in the setup program 

8. Click Test JDBC connection until you see a green tick 

9. Click the Data Handling tick box ensuring STRING fields are handled as UTF-8 

 

Patch 2 onwards 
 

10. In the License server section, click Test connection 

11. Scroll to the bottom of the screen and click OK 

12. You should now see a login screen, this is an indication everything is good to go. 

13. Close your browser.  

 
  

http://localhost:5002/
http://myserver123:6181/
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12. Configure V1SmartMail for receiving emails 

12.1 PIA 
 

R13 introduced a new inbound email polling facility called V1SmartMail. 

 

It allows an unlimited number of mailboxes to be polled for attachments and where found, 

extract them. 

 

Now installed, it must be configured.  

 

The following steps walk you through exactly what configuration is needed. 

 

Assumptions: 

  

 You must be logged on to the V1 Server where the Server installation has been 

performed 

 The PIA installation is under C:\V1 

 You have access to the mail server you intend to use and the capability to create 

/ administrate mailboxes. Have the credentials to hand. 

 As an example, your domain is mycompany.com. Change as appropriate. 

 

Pre-Requisites 

 

 invoices@mycompany.com 

 

This is an external mailbox. 

 

If your suppliers wish to send you PDF Invoices electronically, supply them with this 

email address. 

 

  

mailto:invoices@mycompany.com
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Procedure 

 
1. Using File Explorer, navigate to C:\V1\Utils 

2. Right click and run as administrator the start_services_debug_smartmail.bat (this starts the V1 Smart 

Mail service in debug mode.  

 

NOTE: V1 Smart Mail can only be configured in debug mode to prevent erroneous usage 

 

3. Open your Web Browser of choice and navigate to http://localhost:8444, this is the configuration screen 

 

General Configuration 

 
4. Set log mode to console and file 

5. Set Log Level to log errors only 

6. Set Store log file Audit to yes 

7. Set Purge log files older the # days to 30 

8. Using File Explorer, ensure the path to cscript.exe is correct 

9. Set cycle mailBoxes to run continuously 

10. Set poll time in seconds to be no lower than 30, 60 seconds or higher is advised 

11. Click the dustbin icon to remove any sample Mail Servers 

 

Add your mail server 
 

12. Click the Add new Server icon to add a new server. Enter your intended mail server configuration, give it a 

meaningful name as it will be used to identify it. 

13. Click the Add new Mailbox icon to a new mail box 

14. Add an identifier of PIA 

15. Ensure the Server ID is the same as the one configured 

16. Enter an email address of invoices@mycompany.com 

17. Enter the password to access this mailbox 

18. Click the box Enabled 

19. In the first dropdown, select EXTRACT as the action 

20. Where prompted for File extensions, enter PDF 

21. Supply an Attachment path of C:\V1\SMARMAILS\PIA\PDFS 

22. In the dropdown below, select SAVEMSG 

23. Supply a Save Message path of C:\V1\SMARMAILS\PIA\EMAILS 

24. Tick the middle two options, leave the first and last un-ticked 

25. In the dropdown below, select DELMSG 

26. Click OK 

27. Click Save configuration at the bottom of the screen. 

28. Close your browser 

29. Go back to the CMD window you launched to start V1 SmartMail in debug mode, close the window 

30. Open services.msc and start V1 SmartMail service.   

http://localhost:8444/
mailto:invoices@mycompany.com
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13. Configure V1SmartMail for sending Emails 
 

As well as receiving emails for PIA from Suppliers extracting their attachments, V1SmartMail 

is now the default method to send / relay emails externally.  

 

This could be in conjunction with EDD for sending out your Statements to customer’s 

electronically, receiving alerts from EDM or the OnHold status of a document in PIA. 

13.1 Licensing 
 

In order to use V1SmartMailSend, it must be specifically licensed for. 

 

Ensure you have your license before proceeding, it is located on the V1 Server in the 

\V1\SmartSuite\SmartMail\licenses dir: 

 

 
 

If this dir is empty / does not reflect the above, you must request one from your V1 Account 

Manager / Sage / Partner before proceeding. 

 

Where received, copy it in place before the following procedure. 

Where in place, continue to the procedure. 
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Procedure 

 
1. Using File Explorer, navigate to C:\V1\Utils 

2. Right click and run as administrator the start_services_debug_smartmail.bat (this starts the V1 Smart 

Mail service in debug mode.  

 

NOTE: V1 Smart Mail can only be configured in debug mode to prevent erroneous usage 

 

3. Open your Web Browser of choice and navigate to http://localhost:8444, this is the configuration screen 

4. Click on Configure SMTP 

5. Ensure the Normal radio button is selected 

6. Click the dustbin removing any sample configuration to ensure a clean system 

 

Add your mail server 
 

7. Click Add New SMTP 

8. Click Default SMTP 

9. Enter an ID (a meaningful plain English description of the Mail Server) 

10. Enter the SMTP host based on your provider 

11. Enter the SMTP port based on your provider 

12. If your SMTP provider requires authentication for SMTP, enter the User and Password 

 

NOTE: These details can be left blank if not required 

 

13. Click Test email at the bottom 

14. Enter your email address (or one you have access too) 

15. Where you get a successful message and you receive the test email, configuration is complete 

16. Click Save 

17. Click Save smtp configuration at the bottom of the screen. 

18. Close your browser 

19. Go back to the CMD window you launched to start V1 SmartMail in debug mode, close the window 

20. Open services.msc and start V1 SmartMail service. 

 

  

http://localhost:8444/
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14. Standard Configuration Options for PIA 
 

Assumptions: 

  

 You must be logged on to the V1 Server where the Server installation has been 

performed 

 The EDM installation is under C:\V1 

 PIA has been licensed for  

 The PIA settings file is C:\V1\DbCapture\defs\V1_SETTINGS_DBCAPTURE.def 

 

PIA has a number of configuration options that may be raised by the customer / end user that 

can be easily changed by altering the right setting. 

 

14.1 Display message severity level 
 

The Supplier Document Reference is used to identify whether a document is already in Sage 

and or EDM and as such has a status set on it, or there is a document with the same 

reference in the OnHold queue. 

 

This is white (no issues), yellow a warning and red an error. 

 

The following sets the level of severity for a status on each of the messages back to the end 

user based on an integer value: 

 

0 = OFF 

1 = WARNING 

2 = ERROR 
 

LET CHECK_ARCHIVE_DUPLICATE = 0 

LET CHECK_ERP_DUPLICATE = 1 

LET CHECK_ONHOLDQUEUE_DUPLICATE = 2 

 

In this example, the EDM archive is not checked, if found in the ERP, namely Sage it’ll 

generate a warning but if found in the OnHold queue, generate an error. 

14.2 Grid content choice 
 

Decide which lines are brought back based on the Purchase Order number by setting the 

GRID_ORDER_NUMBER_CHOICE variable. 

 

Setting it to ORDERS will populate the grid with the lines for that Order  

Setting it to RECEIPTS brings back the receipt lines for that Order 
 

LET GRID_ORDER_NUMBER_CHOICE = "ORDERS" 
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14.3 Configure Queue States 
 

A Queue state is effectively an area where documents for specific Sage Endpoints are held. 

 

For example, the customer has 5 Sage Endpoints and these equate to business units, it means 

each have their own queue of Invoices to process without seeing / processing any others from 

other Endpoints. 

 

Out the box, the standard solution has a SEED and TEST Endpoint to allow differentiation, 

but for live implementations, these need to be manually added to the system. 

 

A Queue State is given a unique number and a Sage Endpoint to which it will be associated, 

once assigned, you then simply allocate which DbLogin users can ‘see’ and therefore process 

those documents. 
 

1. Open the DbLogin Admin Console and login as administrator / administrator 

2. Click the Cog and pencil icon at the top (DbCapture Profile Manager) 

3. Double click on PIAExpress 

4. Click on the Queue States tab 

5. Click on SEED and TEST and remove them (or use / rename them, up to you) 

6. Click on Add 

7. Give your queue state a unique number 

8. Set the ‘to be checked’ and ‘on hold’ queue state names to be the name of the Sage Endpoint to which they 

relate (this is the text description the user sees to identify the Sage Endpoint. You’re advised to make them 

both the same.) 

9. Click OK to confirm your choices 

10. Click OK to exit the Profile Properties screen 

11. Click the Save icon to commit the changes, close the DbCapture Profile Manager 

12. Click the tick box to the left of the user(s) you want to assign access 

13. Click the keys icon at the top 

14. In the left hand pane, click on DbCapture in the Application tree 

15. In the DBCSStatesAllowed cell, enter all the queue state numbers you wish to give access that user to. Click 

Save and repeat this for each user as appropriate 
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15. Setting Parameter Values in Sage 
 

The following tasks should be performed on the server where EDM has been installed, 

whether a standalone server, or on the Sage Application Server. 

 

 In our example, the Endpoint is SEED, this procedure needs to be repeated for 

EVERY Production endpoint that wishes to use EDM, change as appropriate 

 In our example, the server IP address or hostname where EDM has been installed is 

MYSERVER123, change as appropriate 

 
1. Make sure you are logged in to the SEED Endpoint  

2. Go to Setup / Parameters > General Parameters > Parameter Values (ADPVAL) 

3. In the Module / Chapter cell, enter ADX and press tab 

4. Click the action button to the left of the ‘EDM connector’ entry and click details 

 

The grid on the following page explains in detail every parameter and the options available 

to you during implementation. 
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Parameter Description Value options to set 

ARCDIR A legacy path to the temp area of the server.  
Although not used now, must still be set to preserve some 

EDD functionality 

C:\Temp 

ARCMAC The Host Machine from legacy versions of EDM. 
No longer used and no value is required. 

N/A 

ARCROOT The Archive URL root address from legacy versions of 
EDM. 
No longer used and no value is required. 

N/A 

ARCROOT2 The Archive URL root2 address from legacy versions of 
EDM. 
No longer used and no value is required. 

N/A 

ARCURL The Archiving URL address from legacy versions of EDM. 
No longer used and no value is required. 

N/A 

ARCV1DIR A legacy path to the temp area of the server.  
Although not used now, must still be set to preserve some 
EDM functionality 

C:\Temp 

EDDFOLDER The UNC path to the EDDOUTBOUNDMANAGEMENT 
directory on the V1 Server. 

\\MYSERVER123\eddoutboundmanagement 

EDDMB Where the EDMARCTYPE is Email, the mailbox to 
receive files that are then distributed via EDD. 

edd@wearev1.com 

EDMARCMA Where the EDMARCTYPE is Email, the mailbox to 

receive files that are then archived as attachments via 
EDM. 

edm_attachments@wearev1.com 

EDMARCMF Where the EDMARCTYPE is Email, the from address 

from where emails sent are received 

admin@wearev1.com 

EDMARCMT Where the EDMARCTYPE is Email, the mailbox to 

receive files that are then archived as transactions via 
EDM. 

edm_transactions@wearev1.com 

EDMARCTYPE If you are on premise or a hosted environment where the 

Sage Application and V1 Server can see one another 
over a network, set to Disk. 
If a Cloud or infrastructure where the two servers cannot 

see one another, set to Email ensuring the mailboxes are 
setup accordingly. 

Disk 

Email 

EDMBCPMB Where the EDMARCTYPE is Email, the mailbox to 

receive files that are then printed as barcodes via EDM. 

barcode@wearev1.com 

EDMCONN Depending on whether the connection to EDM is via http, 
or https, select the appropriate value. 

HTTP 
HTTPS 

EDMIMP The UNC path to the EDMIMPORT directory on the V1 
Server. 

\\MYSERVER123\edmimport 

EDMLINK Set this to 1 if you wish to have the [EDM] View 
Transaction or [EDM] View Attachments links check EDM 
for the existence of a file. If not found, the links will be 

greyed out to benefit the user experience.  
 

0 
1 

EDMMAILMAX The maximum size of an attachment in megabytes 5 

10 
25 
50 

EDMSERVER The IP address or DNS of the V1 Server MYSERVER123 

EDMTYPE Set this to 1 to use SmartRetrieveERP mode and have a 
requirement for a web-login. Set it to 2 to use the EDM 
User profile credentials whose username and password 

are passed as part of the click of the link. Setting it to 2 
means the associated Sage user must have an EDM 
User Profile assigned and that in turn must have the 

DbLogin user / pass. 
 

1 
2 

XV1EDMWSP A legacy value dictating the name of the Classic Pool 

alias for a given endpoint. Although not used now, must 
still be set to preserve some EDM functionality 

X3EDMSEED 

 

5. Once you’ve set your values, Click OK and return the Parameter Values screen 

6. Click Save to commit the settings 

7. Click Close Page 

 

NOTE: Do not put quotes or have spaces in any of the above paths.  
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16. Setting Destination Values in Sage 
 

Q: What is a Destination? 

A: A Destination in Sage X3 where EDM is concerned relates to its behavior. 

 
1. Go to Setup / Parameters > Destinations > Destinations (GESAIM) 

2. Click on each of the Destinations with a description containing ‘[EDM]’ and for each, click the magnifying 

glass in the Server cell. This should bring in the default print server. 

3. Click Save. 

 

The above is all you have to do, below explains each area: 

 

Active 

Tick the box to activate the destination 

 

Access Code 

Optional, to assign a specific user to trigger the process 

 

Output Type > Archiving 

Indicating it is used in conjunction with EDD / EDM 

 

Destination File 

Leave blank 

 

Server 

The print server to use to serve the request for  

 

Export Format 

PDF 

 

Destination Behavior 

ARCHIVE Just archives a pre-existing Sage X3 transaction and does not distribute it. 

AUTO Distributes a document automatically deciding whether to email, fax or print it in that order 

EMAIL Forces the emailing of a document where found, archives it and prints if no email found. 

EMAILONLY Forces the emailing of a document where found, does not archive it and prints if no email found. 

FAX Forces the faxing of a document where found, archives it and prints if no email found. 

FAXONLY Forces the faxing of a document where found, does not archive it and prints if no email found. 

PRINT Forces the printing of a document where found, archives it. 

PRINTONLY Forces the printing of a document where found, does not archive it. 
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17. Add the Drilldown, Archive and Print Barcode Links in Sage 
 

A drilldown is a means to view an archived image from within the Sage object to which it 

relates. 

 

There are 2 drill downs as standard, 1 for the transaction (such as a Purchase Invoice created 

by PIA) and 1 for any attachments to those transactions archived using SmartDeposit via the 

Transactional Attachments table for instance. 

 

[EDM] View Transaction 

[EDM] View Attachment 

 

When either is clicked, it will launch SmartRetrieve and you will see any images archived 

against that object. 

 

There are also 2 links to archive adhoc files, again 1 against the transaction 1 as an attachment 

to it. 

 

[EDM] Archive Transaction 

[EDM] Archive Attachment 

 

When either is clicked, it will prompt you to drag and drop any file which is then automatically 

archived against either the transaction or attachment respectively as a background task. 

  

The final link is to print a barcode, directly from the object. When affixed to the paper copy of 

the document and scanned using DbScanner, is then indexed and viewable via the 

transactional drilldown (more information on this in the DbScanner crib sheet.) 

 

[EDM] Print Barcode 

 

 
 

 NOTE: In the majority of browsers, popups are blocked. Ensure the first time a link is 

clicked, you ‘allow’ popups from the V1 Server. 
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The following must be repeated for each Sage Endpoint patched for EDM. 

 

Change as appropriate for those objects you wish to add the capability. 

 

This can be time consuming, so you are advised to ask the customer which documents they 

intend to use on a day to day basis and only activate those. Any further activations can be 

done on an adhoc basis.  

 

As per the following instructions, most window codes are an O (the letter) followed by the 

object name, so OPIH for Purchase Invoices, OSIH for Sales Invoices and so on. 

 

Where applicable, the associated entry transaction must be re-validated to activate the link. 

 

Below is an example of the PIH object (a very common one to use) use the table 

on the next page as reference for additional objects and the Entry Transactions. 

 
1. Log in to the Sage as ADMIN (or equivalent user)  

2. Change your Sage Endpoint to SEED 

3. Navigate to Development > Script Dictionary > Windows (GESAWI)  

4. In the Window cell at the top of the screen, enter OPIH and press TAB (O the letter not the number)  

5. Click the Button/Menu tab  

6. Scroll to the bottom and double click in the first available blank cell, reflect the below: 

 

 
 
7. When completed, click Save, then Validation 

 

NOTE: Regardless of object, ensure: 

 

[EDM] View Transaction is given a y code and  

[EDM] View Attachment a v code  

 

To ensure they glow / dim depending on the availability of a document. 
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Revalidating the entry transactions 

 

Once links have been added to a Window, where applicable, the Entry Transaction that wishes 

to use them must be re-validated. 

 

Using the table below for reference, it shows you the Sage X3 Object, the window supported 

and where applicable, which menu in Sage is the Entry Transaction. 

 

For each found and where the link is required, select it in the left list and click Validation on 

the right. 

 

Sage X3 Object Window Entry Transaction 

BPC OBPC N/A 

BIC OBIC N/A 

BOL OBOL N/A 

SDH OSDH Parameters > Sales > Shipments 

SRH OSRH Parameters > Sales > Customer Returns 

GAS OGAS Parameters > Financials > Journal Entry Transactions 

PAY OPAY N/A 

ITM OITM N/A 

POC OPOC Parameters > Purchasing > Contracts 

PIH OPIH Parameters > Purchasing > Invoices / Credit Memos 

POH OPOH Parameters > Purchasing > Orders 

PTH OPTH Parameters > Purchasing > Receipts 

PSH OPSH Parameters > Purchasing > Requests 

PNH OPHN Parameters > Purchasing > Returns 

FRM OFRM N/A 

PQH OPQH Parameters > Purchasing > RFQs 

SOR OSOR Parameters > Sales > Contracts 

SIH OSIH Parameters > Sales > Invoices 

SOH OSOH Parameters > Sales > Orders 

SQH OSQH Parameters > Sales > Quotes 

REL OREL N/A 

BPS OBPS N/A 

BIS OBIS N/A 
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18. Configuring Suppliers for PIA Recognition in Sage 
 

When an Invoice is imported into PIA, the first piece of information identified is the Supplier. 

 

In order to do that, a reliable and unique value must be used. For a GB Invoice for instance 

this is the VAT number. 

 

When this is identified, a lookup is done in to Sage X3 to find a VAT number and using this, 

the code, name, currency and address details can be populated in DbCapture. 

 

The primary method of identification for capturing supplier information is to use the content of 

the Intracommunity VAT no (EECNUM) field, (CRN) field or SIC Code (NAF) fields on the 

Supplier Screen. Common Data > BPs > Suppliers (GESBPS). If any of these fields are 

populated and those values found on an Invoice, they are used to then identify the supplier. 

 

The below example would be typical of a GB Supplier: 

 

 
 

Once the first Invoice for a given Supplier is Accepted, this information is stored as a template 

for every subsequent document by that supplier. 

 

Customers who implement PIA are encouraged wherever possible to take the time to 

fill in the appropriate fields for all their Suppliers (GESBPS). Doing so will greatly 

improve the user experience.  

 

You are advised to nominate a ‘top ten’ suppliers to take the time to populate these 

fields and add more as time allows. 

 

Example: 

 

 A Sage customer has a Supplier Joe Bloggs Ltd. They have a UK VAT number of GB741555888. 

This value is entered against them on the GESBPS screen in the Intracommunity VAT no cell and 

saved. 

 Finance at Joe Bloggs Ltd send an Invoice as a PDF attachment. V1 Smart Mail picks this up and 

automatically import it in to PIA. Because the Intracommunity VAT no has been configured, the 

supplier details are automatically populated based on the ‘match’ between system and document. 
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19. Final Standard Implementation Steps 
 

Before use, it is a good idea to do a final rebuild if indexes and restart all services to ensure 

the system is ready for use. 

 

 In our example, the server IP address where EDM has been installed is 

172.26.49.214, change as appropriate 

 
1. In your web browser of choice, browse to http://172.26.49.214:5002 

2. Login as administrator / administrator 

3. Change the url from http://172.26.49.214:5002/portal to http://localhost:5002/config and press enter 

a. This is a back door to the config and not exposed for general use 

4. Click Configure integration server 

 

NOTE: Once you have archived your first document either via EDM or PIA, you must 

carry out the following step in order to see images in SmartRetrieve. 

 
5. Scroll down about half way and click the button ‘Rebuild all search indices’ 

6. Nothing will apparently happen, but no errors assume a successful rebuild. 

 

You’re ready to go! 

 

 

  

http://172.26.49.214:5002/
http://172.26.49.214:5002/portal
http://localhost:5002/config
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20. Non-Standard Implementation Options 
 

The previous chapters are compulsory to ensure a functional system, however there are some 

steps that are optional. 

 

You’re advised to familiarize yourself with the following should the customer have 

requirements beyond the ‘out the box’ functionality. 

 

It is split into sections for each module, EDD, EDM and PIA, go to the section where you have 

Non-standard implementation requirements. 
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21. EDD 

21.1 Configure Printers per Sage user 
 

Assumptions: 

  

 You must be logged on to the V1 Server where the Server installation has been 

performed 

 The setup program has been ran and the default Transactional and Barcode 

printers have been configured 

 The printers to be used are shared and visible over the same network as the 

default printers 

 The EDM installation is under C:\V1 

 

The standard installation will configure both barcode and transactional printers for day to day 

usage for those outbound documents that may require printing. 

 

Very often this is all that’s required, however larger customers may wish to configure printers 

for individual users. 

 
1. Navigate to C:\EDMR13, right click and run setup.exe AS ADMINISTRATOR 

2. Select the Server Installation radio button and click Next > 

3. An existing Server Installation is detected and you’re given several options, select Manage printers per Sage 

User and click Next  > 

4. Where prompted, enter the Sage user (Sage user, not Syracuse user) as it appears in Sage 

5. Confirm the desired location of the Transactional Printer for this user 

6. Confirm the desired location of the Barcode Printer for this user 

7. Click Apply 

 

Technical Detail 

 

A simple ini file is created beneath the C:\V1\EDMPRINTMANAGEMENT dir matching the 

user setup, so a PETE Sage user would have a PETE.ini file. 

 

This contains the path to both the chosen transactional and Barcode printers. 

 

When an outbound destination is triggered, the PDF is split and printing is done in this 

priority: 

 

 If the report passes a printer, this takes priority 

 If the report doesn’t have a printer and a USER.ini exists, this is used 

 If neither the report has a printer nor no USER.ini is found, the default is used as 

per the initial setup. 
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22. EDM 

22.1 Configure DbLogin Alerts  
 

Out the box, several DbLogin users are added so the system can be used immediately, 

however there are some minor additions needed. 

 

EDM has the concept of alerts informing users of any issues or activity for their attention that 

may arise during day to day usage of the software. 

 

ITDEPT 

This represents the I.T department / individual responsible for monitoring alerts. 

 
1. Open the DbLogin Admin Console and login as administrator / administrator 

2. Click the blue / green icon at the top, ‘User Details’ 

3. Click ITDEPT, click Edit 

4. Enter an Email address for the internal I.T Department. They are informed via email serious alerts / errors if 

seen during day to do usage of the system. 

5. Click Update 
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22.2 Configure User Access to Document Types 
 

Example: 

 

 I want to limit my user PETE to only have access to Purchase Orders 

 
1. Open the DbLogin Admin Console and login as administrator / administrator 

 

2. Click the  icon at the top of the screen 

3. Click the  at the top of this screen 

4. Give your access level a meaningful name, i.e. ACCESSPURCHASEORDERS, click OK 

5. The default access is nothing. To enable access to Purchase Orders, click the Purchase Orders Cell and 

click the icon at the top of screen 

6. Notice the status now changes to Full, now click the  at the top of the screen 

7. Repeat the above steps per access level you wish to add per document type 

8. Close the DbArchive Access Permissions Editor 

9. From the grid, select the checkbox next to the PETE user and click the icon at the top of the screen 

10. In the component tree, single click DbArchive 

11. In the right hand panel, notice a drop down for Value of Access level. Select the drop down and click 

ACCESSPURCHASEORDERS which should be in the list. Click Save 

 

Repeat the above steps per user per access level you wish to create 
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22.3 Activating FTS 
 

SmartRetentions for V1 Document Management gives users control over the handling of 

document deletion, both manually and automated.  

 

SmartRetentions will aid users to fulfil their obligations regarding personal data retention as 

determined by the GDPR regulations. 

 

An optional enhancement of SmartRetentions is the EDM database has Full Text Search 

enabled.  

 

This means the content of a document is read as a background task using the ABBYY OCR 

Engine, can be searched on and therefore found using normal SmartRetrieve wildcard search 

or as part of a rule in SmartRetentions. 

 

FTS is an optional, chargeable addon and you’re advised to discuss it with your Sage or V1 

Account Manager prior to implementing. 

 

To apply it to your EDM solution whether as a new installation or retrospectively: 

 
1. Navigate to C:\EDMR13, right click and run setup.exe AS ADMINISTRATOR 

2. Select the Server Installation radio button and click Next > 

3. An existing Server Installation is detected and you’re given several options, select Add FTS capability to 

EDM and click Next  > 

4. When prompted, browse to the path of your licenses 

5. Where found, the Install button activated 

6. Click Install 

 
NOTE: As FTS needs ABBYY installed and as PIA / SOA already use ABBYY, if found, it will use the existing 

installation. If not found, ABBYY will be installed automatically. If so, follow the instructions as per PIA / SOA 

to activate it. 

 
7. The ‘DbArchive: FTS Indexing’ service is installed, activated and relevant settings added to dbarchive.ini 

8. Click Close 

 

No further configuration is required, images are retrospectively indexed if added to a legacy 

archive and from now on to a new installation. 
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22.4 Advanced Configuration Options 
 

Assumptions: 

  

 You must be logged on to the V1 Server where the Server installation has been 

performed 

 The EDM installation is under C:\V1\ 

 PIA has been licensed for  

 Patch 1 has been installed / applied 

 Patch 2 has been installed / applied 

 Patch 3 has been installed / applied 

 

EDM for Sage X3 has flexibility in the way the system can be relay emails. 

 

The following def files can be modified to decide how you wish to do this: 

 
 \EDDOUTBOUNDMANAGEMENT\EDDOUTBOUNDMANAGEMENT.def 

 Handles the delivery of all outbound documents generated by Sage X3 

 \EDMIMPORT\EDMIMPORT.def 

 Handles the automatic archiving of all images, whether from internal archiving 

(click a link in Sage X3) or from EDD where EDM is also installed 

 \EDMPRINTMANAGEMENT\Print_Pickup.def 

 Should an outbound document require printing, or a barcode is printed, this file 

handles it 

 

Editing any of these def files for the following value allows you to decide whether to use 

SmartMailSend to send emails or DbMail. 

 
Let Mail=0 

 

Setting this value to 0 (the default) will use SmartMailSend to relay all emails from EDM for 

that def file. 

 

Setting this value to 1 will use DbMail to relay all emails from EDM for that def file. 
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22.5 Configure V1 SmartMail 
 

R13 introduced a new inbound email polling facility called V1 SmartMail, from Patch 2 onwards 

V1 SmartMail can also be used to relay outbound emails. 

 

It allows an unlimited number of mailboxes to be polled for attachments and where found, 

extract them, or send them. 

 

These attachments can then be archived in to EDM, or passed to PIA or SOA to be processed 

as Invoices / Orders respectively. 

 

Now installed, it must be configured. The following steps walk you through exactly what 

configuration is needed. 

 

Assumptions: 

  

 You must be logged on to the V1 Server where the Server installation has been 

performed 

 The EDM installation is under C:\V1 

 You have access to the mail server you intend to use and the capability to create 

/ administrate mailboxes. Have the credentials to hand. 

 As an example, your domain is mycompany.com. Change as appropriate. 

 The Inbound mailbox has already been configured as part of the standard 

implementation guide 
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Pre-Requisites 

 

 Create the following mailboxes on your mail server of choice: 

 

 edd@mycompany.com 

 edm_transactions@my.company.com 

 edm_attachments@mycompany.com 

 barcode_print@mycompany.com 

 

These mailboxes are for internal use and should not be supplied to anyone outside your 

organization. They are used in conjunction with EDD and EDM. 

 
1. Using File Explorer, navigate to C:\V1\Utils 

2. Right click and run as administrator the start_services_debug_smartmail.bat (this starts the V1 Smart 

Mail service in debug mode.  

 

NOTE: V1 Smart Mail can only be configured in debug mode to prevent erroneous usage 

 

3. Open your Web Browser of choice and navigate to http://localhost:8444, this is the configuration screen 

 

Add your inbound mailboxes 
 

The following mailboxes all have a specific role and have been split accordingly based on what you are licensed 

to use. 

 

Those for EDD and EDM are for Patch 2 onwards only and are used if direct disk access is not permitted from 

the Sage Application server to the V1 Server to transfer files. 

 

4. Click the dustbin icon to remove any sample mail boxes 

5. EDD 

 

5.1. Click the Add new Mailbox icon to a new mail box 

5.2. Add an identifier of EDD 

5.3. Ensure the Server ID is the same as the one configured 

5.4. Enter an email address of edd@mycompany.com 

5.5. Enter the password to access this mailbox 

5.6. Click the box Enabled 

5.7. In the first dropdown, select EXTRACT as the action 

5.8. Where prompted for File extensions, enter PDF 

5.9. Supply an Attachment path of C:\V1\EDDOUTBOUNDMANAGEMENT\SmartMail 

5.10. In the dropdown below, select DELMSG 

5.11. Click OK 

 

  

mailto:edd@mycompany.com
mailto:edm_transactions@my.company.com
mailto:edm_attachments@mycompany.com
mailto:barcode_print@mycompany.com
http://localhost:8444/
mailto:edd@mycompany.com
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6. EDM 

 

6.1.1. Click the Add new Mailbox icon to a new mail box 

6.1.2. Add an identifier of EDM_TRANSACTIONS 

6.1.3. Ensure the Server ID is the same as the one configured 

6.1.4. Enter an email address of edm_transactions@mycompany.com 

6.1.5. Enter the password to access this mailbox 

6.1.6. Click the box Enabled 

6.1.7. In the first dropdown, select EXTRACT as the action 

6.1.8. Where prompted for File extensions, enter * 

6.1.9. Supply an Attachment path of C:\V1\EDMImport\Transaction 

6.1.10. In the dropdown below, select DELMSG 

6.1.11. Click OK 

 

6.1.12. Click the Add new Mailbox icon to a new mail box 

6.1.13. Add an identifier of EDM_ATTACHMENTS 

6.1.14. Ensure the Server ID is the same as the one configured 

6.1.15. Enter an email address of edm_attachments@mycompany.com 

6.1.16. Enter the password to access this mailbox 

6.1.17. Click the box Enabled 

6.1.18. In the first dropdown, select EXTRACT as the action 

6.1.19. Where prompted for File extensions, enter * 

6.1.20. Supply an Attachment path of C:\V1\EDMImport\Attachment 

6.1.21. In the dropdown below, select DELMSG 

6.1.22. Click OK 

 

6.1.23. Click the Add new Mailbox icon to a new mail box 

6.1.24. Add an identifier of BARCODE_PRINT 

6.1.25. Ensure the Server ID is the same as the one configured 

6.1.26. Enter an email address of barcode_print@mycompany.com 

6.1.27. Enter the password to access this mailbox 

6.1.28. Click the box Enabled 

6.1.29. In the first dropdown, select EXTRACT as the action 

6.1.30. Where prompted for File extensions, enter TXT 

6.1.31. Supply an Attachment path of C:\V1\EDDPRINTMANAGEMENT\BARCODE 

6.1.32. In the dropdown below, select DELMSG 

6.1.33. Click OK 

 

7. Click Save configuration at the bottom of the screen. 

8. Close your browser 

9. Go back to the CMD window you launched to start V1 SmartMail in debug mode, close the window 

10. Open services.msc and start V1 SmartMail service. 

 

 

 

 

  

mailto:edm_transactions@mycompany.com
mailto:edm_attachments@mycompany.com
mailto:barcode_print@mycompany.com
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23. PIA 

23.1 Configure DbLogin Alerts  
 

Out the box, several DbLogin users are added so the system can be used immediately, 

however there are some minor additions needed. 

 

PIA and SOA have a concept of On Hold codes (see the crib sheet on the portal for more 

details) which if configured allow optional email alerts to be sent to a department (or individual) 

should a document require a degree of workflow. 

 

Like EDM, PIA has the concept of alerts informing users of any issues or activity for their 

attention that may arise during day to day usage of the software. 

 

APDEPT 

This represents the Accounts Payable department / individual responsible for monitoring 

alerts.  

 

ARDEPT 

This represents the Accounts Receivable department / individual responsible for monitoring 

alerts. 

 

ITDEPT 

This represents the I.T department / individual responsible for monitoring alerts. 

 
6. Open the DbLogin Admin Console and login as administrator / administrator 

7. Click the blue / green icon at the top, ‘User Details’ 

8. Click APDEPT, click Edit 

9. Enter an Email address for the internal Accounts Payable department (or individual who will receive alerts 

from PIA.) 

10. Click Update 

11. Click ARDEPT, click Edit 

12. Enter an Email address for the internal Accounts Receivable department (or individual who will receive alerts 

from SOA.) 

13. Click Update 

14. Click ITDEPT, click Edit 

15. Enter an Email address for the internal I.T Department. They are informed via email serious alerts / errors if 

seen during day to do usage of the system. 

16. Click Update 
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23.2 https configuration 
 

If using a https connection it is a requirement to have a SSL certificate. 

 

These come in 2 categories: 

 
1. Self-signed – One that has not been paid for 

2. Signed – One that is paid for and certified by a known provider 

 

NOTE: It is not V1’s responsibility to provide a certificate for use with https. 

 

NOTE: Ensure your certificate has been added using the relevant mmc SnapIn before 

continuing. 

 

From the properties of the certificate, copy the Thumbprint value to your clipboard. 

Remove any spaces from thumbprint value if present. It should look like  

 

e93a471cdb901e94a4cea915dbf711ae257de2ae 

(Note that Thumbprint size should be 40 characters long)  

 

 
 

 

Bind SSL certificate 

 
1. Run the SSL Config.exe utility (in the \utils\https directory) as administrator on the V1 Server where PIA is 

installed 

2. Select option 1  

3. Confirm the IP address of the server 

4. When prompted, enter 3 for the number of ports to configure 

5. Enter 31450 

6. Enter 31451 

7. Enter 31452 

8. When prompted, paste the thumbprint value 
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Edit DbCapComms.exe.config 

 

Now the certificate is bound to the ports, the config file must have the values added o 

complete the procedure. 

 
1. In file explorer, navigate to \DbCapture\DbCapComms\ 

2. Using a suitable text editor such as Notepad++, edit the DbCapComms.exe.config file 

3. Edit the following values: 

a. Set the appsetting protocol to https 

 

 
 

b. Add the clientCertificate findValue to align with the thumbprint 

 

 
 
4. Save the file. 

 

Restart the services 

 

Restart the 3 DbCapComms* services. 
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23.3 Advanced Configuration Options 
 

Assumptions: 

  

 You must be logged on to the V1 Server where the Server installation has been 

performed 

 The PIA installation is under C:\V1\DbCapture 

 PIA has been licensed for  

 Patch 1 has been installed / applied 

 Patch 2 has been installed / applied 

 Patch 3 has been installed / applied 

 

PIA for Sage X3 has flexibility in the way the system can be relay emails. 

 

The following def files can be modified to decide how you wish to do this: 

 
 \defs\DELETE.def 

 When a document is deleted from PIA, it is archived and emailed 

 \defs\ONHOLD.def 

 When a document is put on hold in PIA, it is archived and/or emailed based on 

the supported code [ARCHIVE] / [EMAIL] 

 \defs\PDF_Pickup.def 

 When a PDF is found to be deposited, an email is sent to the ITDEPT DbLogin 

user informing them of any issues with its decryption if found 

 \defs\QUEUEMANAGEMENT.def 

 Monitoring the PIA queue of documents to auto accept or inform of future dated 

documents that can be re-instated 

 

Editing any of these def files for the following values allows you to decide whether to use 

SmartMailSend to send emails or DbMail and whether to use the REST API to query user 

details. 

 
Let Mail=0 

 

Setting this value to 0 (the default) will use SmartMailSend to relay all emails from PIA for 

that def file 

 

Setting this value to 1 will use DbMail to relay all emails from PIA for that def file 

 
LET CALL_REST=1 

 

Setting this value to 1 (the default) will use the NIS API to get the email details for a given 

user 

 

Setting this value to 0 will use the legacy method, a binary tool called DBLUQuery. 
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24. Translations 
 

The biggest and most significant enhancement for R13 Patch 3 is that the solution is now 

translatable. 

 

Its implementation is in three parts: 

 

 Core Translations 

 The SmartSuite UI (EDM) 

 DbCapture clients (PIA) 

 Scripting translations, such as text displayed in emails and lookup responses 

 Add-on translations, such as text displayed to a user from day to day activity from 

within Sage X3 

 

The combination of the above means the ‘solution’ is translated, but each area has its own 

method of implementation to allow it to be configured in isolation. 

24.1 Core Translations 

24.1.1 SmartSuite 
 

All translations for UK English and French in the SmartSuite are provided ‘out the box’, so no 

action is needed in terms of additions, however you are advised to be familiar with its setup if 

any changes are required. 

 

A web front end has been provided to allow the SmartSuite UI to be translated, the interface 

is hidden from daily use as it only meant for administrators.  

 

On the V1 EDM Server, open your web-browser and go to: 

 

http://localhost:5002/portal 

 

Login as administrator / administrator 

Manually change the url to: 

 

http://localhost:5002/config 

 

Press Enter 

Click Configure Integration Server 

Scroll about two thirds of the way down and click Manage Translations 

 

Consult the documentation on the Portal for more details. 

  

http://localhost:5002/portal
http://localhost:5002/config
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24.1.1 DbCapture Clients (PIA) 
 

The Client UI’s are translated in 3 parts: 

 

 Interface such as menu items and buttons. 
o These cannot be translated at this time as they are hard-coded in the dll’s provided with the 

client installation. 

 

 DbCapture Profile display names 

o Up to two languages can be used at any one time, the display names are 

separated by a pipe symbol.  
 If no pipe is found, only that string will be used.  

 If a pipe is found, the language to left will be English, the one to the right French and 

so on. 

o To change these values: 
 Open the DbLogin Admin console 

 Click the DbCapture Profile Manager icon 

 Double click on the PIA_Express profile 

 On the Main tab you will see each field and the display name on the pane on the right, 

make any changes you see fit, click OK 

 Click the Save icon at the top to commit the changes 

 

 Messages back to the user from Sage during validation 

o These are taken from the scripting translations covered later in this document 

 

The combination of the above allows a user to flip between English / French and all text they 

see will be in the language they selected with no further configuration required. 

 

24.2 Add-on Translations 

24.2.1 UI Messages 
 

The UI messages are those that pop up from within Sage itself when using EDM, either to 

return information or an error, i.e. if you click on [EDM] Archive Transaction and get a message 

to say “Your Document has been archived successfully” etc … 

 

Repeat the below for each Sage production Endpoint where EDM has been applied and not 

to the X3 Endpoint. 

 
1. Login in to Sage as an ADMIN user and select an Endpoint patched for EDM 

2. Click on > Translations > Import Messages 

3. Ensure Client is selected as the Location 

4. Click OK 

5. Where prompted, from the R13 distribution, navigate to \PATCH\EDM\PROD_ENDPOINT and select 

F1576583282414 

6. Click OK 

7. You should see a log file with reference to the text that has now been imported 
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24.2.2 Link Text 
 

As standard, 5 links are added to the screens where the archiving, viewing of images and 

printing barcodes has been implemented. 

 

These links can be translated so the user can see them in their desired language. 

 
1. Login in to Sage as an ADMIN user and select an Endpoint patched for EDM 

2. Click on > Translations > Text Translation 

3. In the Text search cell in the left list, select contains and enter [EDM] and press enter 

 

 

 

4. This should find 5 links, click on the first one and where prompted for language, enter FRA and press tab 

5. It will default to be the same as English, enter the French translation, click Save 

6. Repeat the above steps for each of the 5 links 
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24.3 Scripting Translations 
 

No web-front end is provided for the scripting / feedback messages from EDD / EDM / PIA, 

however they can be changed manually using a suitable text editor such as Notepad++. 

 

In order to pass variables and therefore correctly construct a sentence in any language, text 

is indexed: 

 

In English would be: 

 

Your search {{0}} has returned no results for Document Type {{1}}, please try again. 

 

In Spanish would be: 

 

Su búsqueda {{0}} no ha devuelto resultados para el tipo de documento {{1}}, intente 

nuevamente. 

 

And so on. 

 

All English and French messages have been provided. 

They can be found on the V1 Server in the \V1Home\SmartSuite\NIS\lang\ directory with a 

suffix of –int.json. 

 


